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1 Scope

“lis document is the functional specification of a Group Configuration Tool (GCT), a software fool providing

: highly interactive, multi-windowing, graphical interface for the creation and management of control appli-

-ations. GOCT is an evolution from the specification of the Generic Application Programming Environment
l GAPE).

This specification gives an introduction to the control model supported by GCT, outlines some architectural
-ansiderations and provides an overview of how a user will interact with the system.

%10 initial implementation of GCT is planned to coincide with the product release of the Fast Machinery
Zontrotler (FMC). This initial release of GCT will include a subset of the features outlined in this specification
restrictions are noted in the text).

2  Related Documents

{1} 1EC DIS 1131-3 (Programming Languages for Programmable Controllers)
(2] CDL Specification (NO NUMBER), J.W. Juer

(3] EP024105: Resource Manager Release | Specification, J.W. Juer

'4] IEC65A Control Languages -~ A Practical View, J. Juer and I.P. Hughes
[5] GAPE Preliminary Specification, M.S. Dillamore and J.J. Oliver

(6] An Overview Of The Resource, L.P. Hughes

3 Glossary Of Terms

o CDL - Configuration Definition Language used to specify all aspects of a distributed control strategy.
« FBD - Function Block Diagram graphical representation of continuous control strategy.

e POU - Program Organisation Unit is a service, program or function block.

» SFC - Sequential Function Chart graphical representation of sequential control strategy.

e ST - Structured Text textual language to specify ail run-time aspects of control strategy.

4 GCT Application Model

CCT enables the user to construct control applications based on the methodology defined in {1] and developed

in {4}
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Figure 1: Relationship of Entities within a Configuration

4.1 Top Level Application Entities

The highest level application entity is known, In IEC terms, as a configuration. A configuration consists of
A resource corresponds to a largely self-contained

niysical unit within the configuration, such as & Eurotherm PC3000 system with a single LCM {(Local Con-

SO

o= or more resources which will be networked together.

ialler Module).

The Rescurce level of CDL consists of a set of blocks that can be wired together, and divided into subsets

t=at run under the control of a task.

4 resource definiticn can be modified on line. This is desirable to debug parts of an application when other
carts of a control system need to be kept running. This concept will be supported by allowing dypamic on-line
wu’mg of blocks, deletion and addition of block and tasi instapces at the Resouzce level of the [EC 1131- 3

nierarchy. GCT will (in later releases) support this.

Pasources have the ability to refersnce blocks and parameters in other resources, with bindings between
resources being resolved at run-time. This late binding facility is considerably more flexible than the basic
[=C model, allowing e.g. a new PO resource to access values froma PC3000 resource which had been previously

dafined, and without modifying the PC3CC0 resource.

4.2 Blocks

All application entities within this methodology are blocks which have an interface, internals and a body.
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22,1  Block Interface

~he block interface consists of a number of parameters that may be viewed and used by other blocks. The
‘1terface is independent from the implementation of the body of the block and allows a common view of all

“locks.

1 222 Block Internals

The internals of a block specify the entities that are referenced in the implementation of the body of the block.
The repraseatation of the internal declarations is also common to all block types and is independent from the
‘mpiementation of the body. Some internals are implicitly declared eg an SFC body includes step, transitions
:nd actions.

2.2.32 Block Body

The body of a block is the actual algorithm that is associated with the block. The body may be implemented
1sing one of a suite of [EC languages (sg SFC, 5T, atc), or using another language (eg C, spreadsheet, etc).

The representation of the body of a block will depend on how it was originally defined. When the body of a
~ew block is first opened for edit, an option is given to select ope of a number of editors that are appropriate
“or she given block type. The selected editor will then be invoked to allow the body to be defined. Thereafter
:he body will retain its body editor type and whenever it is selected for display or modification, the respective
=dizor will again be invoked.

[0 some cases it will be possible to display or transform a block body info a simpler representation (usually
20 ST text), eg SFC to ST. It will not be possible to transform to a more complicated body type although
default generation of graphics may be supported in future releases.

initially only ST text and SFC body editors will be supported. The details of these are described in later
sections.

4.2.4 Block Types

Block tvpes supported include:

+ Configuration

Specifies one or more networked resources that are allocated to run on physical nodes.

+ Hesource

Contains resource level blocks of type task, service, program and function block and the wiring between
them.

e Task

Tised to specify the execution rate of blocks that are assoclated with it.

« Program

A program is a function block that can only be instantiated at the resource level.
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+ Function Block

A function block consists of a number of input parameters that will be processed to generate a number af
sutput parameters. The values of the input and culput parameters will be retained from one execution
of the bleck to the next.

+ Service
A service block is internal to a program or function block. Services are a CDL extension to the IECED
standard and are designed to provide remote procedure call and synchronisation of tasks across the
networks. Services provide extra methods for a program or function block resulting in modular block
definisions and making it easier to construct distributed appiications.

» Function

A function has one or more named inpub parameters which will be processed to return a value of a
specified data type.

s Step
4 block that is internal to another block that is defined using the SFC graphical language. A step
specifies a number of actions and qualifiers that will be executed when the step is active.

® ’]}f&DSItIOQ

A block that is internal to another block that is defined using the SFC graphical language. A transition
specifies a condition which will cause previcusly active step(s) to be cleared and subsequent step(s) to
be made active.

e Action

A block that is internal to another block that is defined using the SFC graphical language. An action
specifies some code that will be executed when the steps that it is associated with are actlive,

Tigure 1 illustrates the relationships between the different entities within this methodology.

1.3 Block Hierarchy

As has been said, one of a pumber of languages may be used to define the body of a block. Many of the
languages involve either the explicit or implicit internal declaration of other blocks.

« A configuration may contain resources.

e A resource may contain task, services, programs and function blocks.

e A service may contain function blocks and may invoke functions. A service body may be defined using

SFC.

o A program may contain fanction blocks and may invoke functions. A program body may be defined
using SFC.

o A function biock may contain function blocks and may invoke functions. A function block body may he
defined using SFC.

« A block with an SFC body {eg service, program, function biock, action), will contain steps, transitions
and actions.

« An action body may be defined using SFC. Alternatively an action may invoke functions.
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Figure 2: Hierarchy Of Blocks Within An Application
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Tus it can be seen that the application model is bierarchical. Figure 2 shows the hierarchical relaticnship
bacween the different types of blocks in an application.

GOT being based on this hierarchical model will equally support top-down, bottom-up or middle-out config-
zmation of the control strategy.

4.4 Librarles

4 henefit of the hierarchical, block model is that applications will be highly structured and will encourage
te reuse of previously defined blocks. To this end, GCT incorporates library managerment features. Blocks
may be grouped into libraries based on criteria such as specific run-fime target functionality or an area of
zyplication. Applications can make use of previously defined libraries. Standard Libraries will be supplied by
Furotherm. GCT may also be used to generate a user library which can in turn be used by other applications.

4.5 Projects

% number of configuration definitions may be used to allocate a set of resources 0 physical nodes on a
-stwork in different ‘configurations’. A number of alternate resource definitions may be used on the same
zhysical network to effect different control strategies. GCT manages such  set of related configurations and
resources in a project.

15 GOT is used to define hierarchical resources, new blocks will be created. These blocks will be stored in
: library that is private to the current project and will not be freely accessible to other applications. It will
owever be possible to use library menagement features to take 2 block from a project library and include it
‘n a shared library.

Tigure 3 Illustrates the entities managed within a GCT project.

5 GOCT Architecture

5.1 Open Architecture

The GCT software will consist of a suite of front-end utilities ¢hat will act on an underlying database (GCT
Object Manager), supporting the creation and management of CDL objects (see Figure 4). The GCT archi-
secture will be highly modular, with the disparate atilities having a minimal interface with the rest of GCT
{except via the Object Manager), and such that additional utilities and support for additional target cortrol
systemns may be easily incorporated as required (see Figure 5).

5.1.1 Use Of CDL

CDL provides a canonical, portable, extensible representation of all aspects of a control strategy. The use of
this common representation will allow the sharing of tools and of application code between muitiple configurers
and target systems.

GCT will be able to import free format CDL definitions and present them for display and editing. In the
future GOT utilities will also support the generation of defauit graphics to allow a plain textual definition to
be viewed graphically.
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PROJECT: myproject

(USES LIBRARIES:iba,libb,libc)

CONFIGURATIONS:
myconfl mycon{2 sd\oo:a__ , myconfd
RESOURCES:
myrscl myrscz myrsc3 myrcs4

BLOCK TYPES(private to project}:

myfbl

These blocks form a project library. The blocks may be accessed via library

myfbh2

A configuration specifies the allocation of Resource
definitions to physical nodes.
A Configuration may contain > 1 Resource allocations.
A Resource may be referenced in > I Configurations.

ﬁ zd%::ﬁ _ :dﬁﬁomﬁ

myfun?2

manageiment operations eg to copy block to or from another library.

Figure 3: GCT Project
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Front-and utilities, 2.g.
COL taxt, SFC, FEO,

Varsion conirol atc.
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Figure 4: High-Level GCT Dataflow Diagram

JNTROLLED DISTRIBUTION COPY
ONLY IF COLOUR STAMPED ON
CONTROL SHEET.

DOCUMENT
REVISION

1

Group Configuration Tool

Provisional Functional Specification

EUROTHERM

@ Copyright 1992 Eurotherm Limited

El

NO NUMBER, For Information Only

DOCUMENT NUMBER SHT.

12

LR EERGY Y



(5oL Cject \

! ¢\ Manager M
! |

' 1
H

COL Object Store

i i

Read/
Gansrate GDL 1

| I

COL Text Files

Gansrate

Ganaric Cods

Ganeric
Coda

Target-specific

intarfaces

i

Target-spacific Data

i
i
r Read Targst |
Matrics

i

Target
Exscutables

Target Metrics

Generate
Target
Cods

Figure 5: GCT Dataflow Diagram showing Target Independence
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5.1.2  CDL Object Manager

Tte purpose of the CDL Object Manager is to offoad all aspects of managing CDL objects from the various

cat-end utilities that wish to manipulate CDL objects. Functions such as creation, parsing, storing, loading,
browsing, code generation, on-line access, download, 2tc will be handled by the Object Manager in a consistent
way and will not have to be reproduced and maintained by multiple applications.

5.1.3 Incorporating Additional Front-End Utilities

Tnche GCT architecture, the GCT Object Manager will support all the aspects of the creation and management
of CDL objects. This means that all editors that are capable of manipulating CDL objects may use the Object
Mznager and will not have to support this management themselves.

A example of this would be tne MicroCell spreadsheet representation of an SFC, The spreadshest represen-
rasion uses columns to represent steps. Each column bas a transition associated with it and the next step(s)
to make active. Variables are listed in the leftmost column. If & variable is to be assigned to in a given step,
then the value or expression is specified in the row of that step column that corresponds to the variable in the
lefimost column that is to be updated. A spreadsheet editor may be incorporated into the GCT by calling
Object Manager transactions to create steps, transitions and actions.

Orher information required by the spreadsheet editor may be handled by the Object Manager using attributes.
CDL supports the definition of user sttributes that may be associated with any CDL object. The spreadsheet
editor might want to save bhe row numbers used by the named variables that wili reside in the left hand
column of the spreadsheet.

The Object Manager would then handle the parsing, storing and code generation for that CDL definition.

If necessary a front-ead utility may also maintain files specific to its own format eg for editor characterisation.

5.1.4 TIncorporaiing Additional Target Support

The Object Manager generates CDL for the specification of all aspects of a control strategy. CDL is an
extensible language and may be used to include user defined attributes. It Is this use of a well defined,
canonical representation thas enables GCT to be a generic configuration environment for multiple targets.

GCT may be configured to allow support of a target system provided that the control model for the target
svstem can be represented by CDL (or a subset of CDL). The target need not support all aspects of CDL, eg
dynamic reconfiguration of the resource level. Many run-time systems consist of a pre-defined set of blocks
and do not support user defined blocks. They correspond well to the Resource level of CDL. Examples of such
systems are T1000 and (possibly} SSD Link.

Iz order to support a new target the areas io address are:

s Target Code Generation
The GCT Object Manager outputs the definition of a control strategy in CDL text.

A translation utility must be developed to generate target code from the CDL definition. A defined
procedure will allow this utility to be installed into the GCT environment and will be invoked by the
Object Manager for code generation for the given target.

The Object Manager may also be used to translate CDL code into C that can be compiled and executed

on a standard CDL engine. Although the execution engine of a specific target may be able to run this
C code, there will most probably be at least a minimal amount of target specific code required to be
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zenerated. In some cases all the CDL to target code may be specific to a target, eg if assembler or
interpreted tokens are required.

e Target Code Build
After target code has been generated, a final build process must be able to generate the final runtime
image from a set of target code files eg by linking with target symbols.
This build utility will be installed into the GOT environment in the same way as the code gemeration
utility.

s Target Comms Driver

The Object Manager will provide 2 generic interface for on-line access from GCT utilities to live target
systems. Ultimately default comms will be based on the Resource. Specific communications driver must
be srovided to allow on-line access to live applications for each supported target.

» Target Specific Front-End Utility

A target specific front-end utility may be required. This can be incorporated into GCT as desribed in
the previous section.

5.2  Multiple Platforms

SCT will be portable across the X window system (initially on Tnteractive 386/ix) and Microsoft Windows
version 3.0 upwards).

The OSF/Motif library will be used in the comstruction of the version of GCT for X, and this version will be
designed to work best when used in conjuction with the Motif Window Manager.

An PCs, GCT will support the following display standards: EGA, VGA, Super VGA (800 x 600 upwards).
Due to the device independent nature of X and MS Windows, support for future display standards of higher
-esolution {e.g. XGA) will be autematic.

5.3 Construction

The GCT development will take advantage of 2 high-level GUI toolkit to increase productivity and ensure
onsistency across supported platforms. The toolkit will suppert interfaciag with other third party libraries
(e.g. GMS on Unix). It is currently envisaged that the toolkit used will be XVT. Use of XVT would also
allow portability to MAC and 0S/2.

1t will be coded primarily in C++, and will reuse code {either C or C+-) from existing programuning tools
where possible.
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& (General User Interface Features

At the highest level GCT will be driven froma horizontal menu bar which will remain ab the top of the screen.

AT GCT usilicies will have a common ‘look and feel’. Utilities will run inside windows and use will be made
of dialogue boxes, lst boxes, icons, and other standard widget types, to facilitate user interaciion.

(3zmeral user interface requirements may be summarised:

Consistent: Use of user interface constructs for similar operations will be consistent across all utilities.

Compliant: The design and behaviour of the user interface must be in accordance with accepted GUI stan-
dards such as Motif and Windows style guidelines.

Responsive: The user interface must appear responsive to user action at all times.

Input devices: GCT will be driven most efficiently using a mouse, but 1t will be possible to work with
kevboard only.

Accelerators: Accelerator keys will be defined for rapid access to frequentiy used menu options.
Non-modal: GCT will contain minimal modality; in general, all utilities will he accessible at all times.

Multi-window: The user will be able to view and modify multiple areas of the configuration simultanecusly,
using different utilities or multiple copies of the same utility as required.

Interoperable: It will be possible to exchange data hetween GOT utilibies, or between a GCT utility and
third party utilities, using a clipboard and other mechanisms (such as DDE) where appropriate.

Multi-user: It will be possible for multiple users to work on applications simultaneously across a network;
library management will control locking and updating of the various components of a configuration.

Tnternatiopal: GCT is targeted at an international market and will therefore provide full multi-language
support, also taking into account date and time formats ete.

6.1 Introduction To Menu Bar Usage

GCT menu bars can be divided into two categories: the main memu which allows access to operations affecting
the entire GCT environment, and menu bars for other views which contain commands for a specific editor
{such as deleting a marked section of 5T text or printing a particular SFC).

The following description of techniques for accessing menu bar commacds applies equally to the main {global)
menu bar and to view (local) menu bars.

The structure of a menu bar coasists of a horizontal menu bar, whose entries. corresponds to a puil-down menu
of commands related to a particular area of functionality (e.g. file handling or accessing help).

Items in the menu bar may be accessed using the mouse by clicking on the required item, or using the keyboard
by pressing the Alt key in conjunction with the underlined {usually the first) letter of the item (e.g. Alt-M to
access the Mode menu).

Having selected a particular pull-down menu, items within the pull-down may be selected either by chicking
on the item with the mouse, or by pressing the Alt key in conjunction with the letter of the item which is
underlined (e.g. Alt-S for Save or Alt-X for Exit, both of these being in the File pull-down).
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lome regularly used commands from the pull-down menus will have corresponding accelerator kevstrokes, 50
‘hat a single keystroke can activate the command without first having to access a pull-down menu. Where
. menuy ‘term has a corresponding accelerator key sequence, this sequence will appear alongside (to the Tight
+{} the item name in the pull-down menu. At present, this specification does not address the assignment of
specific acclerators, although a number of these will be determined by style guidelines. ’

V{enu items which lead to a dialog box {e.g. to allow the setup of command options, ot for confirmation) are
sllowed by an ellipsis (...} when displayed.

T GCT Views

The following sections set out the primary views (modes of interaction} in GCT, and the operations supported
Sv each view. The specific details of the user interaction for each operation are not included but an overview
5f the siyle of interaction is given as an intraduction. Where specific menu structures are given, these are for
the purpose of presenting the operations available. The actual contents and presentation of the menus will be
subject 1o change.

Figure 3 (page 18) gives an overview of the relationship between the different views within GCT. A labelled
hox in the diagram represents a GCT view. The boxes are labelled with the section number in this document
“hat describes that view. An arrow indicates that another view may be opened from that view,

7.1 Philosophy of Operation

There are two tvpes of GCT views. The first type are those that are displayed in the main GCT window, and
that are controlled by the main menu bar -~ these are termed main views. The second type are displayed in
their own windows with their own menu bar these are termed indepedent views. There is only ever cne main
view active ab a time, but there can be multiple active independent views.

GGCT operates on the following types of ohject,

The Project

GCT operates within a project context. The project acts as a ‘folder’ within which Resources, Configura-
tions and the Project Library are stored. The project context maps directly onto a directory. The project
context can be changed from within the tool using File,New Project... or File,Open Project....

A Project is represented and managed by the Project main view (see section 7.2.3 and figure 7, page 23)).

Resources

The Resource represents the control strategy executing within a node. Resources belonging to a project
are listed and managed in the Project main view.

A Resource 1s represented by a Block independent view by the editor that was used to create the Resource
(see section 7.3.1}.
Configurations

Configurations represent the distribution of Resources across physical networks. In Stage I, GCT 1s
limited to a single node networks so the concept of Configuration definition may not be evident. Con-
figurations belonging to a project are accessed and managed via the Project main view.

A Configuration is represented by the Configuration main view (see section 7.2.5).
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Figure 6: Relationships between GCT Views
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Froject Library

“The Project Library is a folder containing all user defined block types that are created within a project.
15 hehaviour and factiities are identical to those of a Shared Library. The Project Library is accessad
snd managed via the Project main view.

Pt

u

A Project Library is represented by & Library main view (see section 7.2.4) or a Library Browser inde-
sendent view (see section 7.3.2). Note that when the Library Browser is invoked from the Project main
iew the main menu bar can be used for library management functions (#.g. copy blocks to another
library). In this context the Library Browse behaves as a main view.

Shared Libraries
4 Shared Library is a folder containing user defined block types that may be used by more than one
aroject. Thelr behaviour and facilities are identical to those of a Project Library. Shared Libraries are
-ccessed and managad via the Project maln view. 12
4 Shared Library is represented by a Library Busaspyindependent view (see section To=21).

Zlock Types
Rlock types are created in a Resource or Library context, They are always saved in a library (Project
or Shared). Block types are managed from the Library Browse view in main view context.

4 block type is represented in a Block independent view by the editor that was used to creabe it

When GOCT starts up, it must establish a project context. By default the project context is desmed to be the
drectory that is current when GCT is invoked. The initial project context can also be set by declaring an
aaproptiate environment variable or from within the tool using Utilities ,SetUp,Defaults.. ..

GCT may be invoked naming a resource, in which case the corresponding block independent view will be
soened as well as the Project main view.

7.2  Main Views

“{ain views all occupy the main window. They are controlled from the main menu bar.

7.2.1 Imitial Banner

The initial view preseated on start up is the GCT welcome screen. Besides a welcome message and copyright
natification, it (may) contain licensing information. This view is replaced by the Project main view once
imtialisation is complete.

7.2.2 Main Menu

The Main Menu is attached to the main window which contains, in turn, all the main views. The main menu
operates on ltems in the current main view and also provides other functions global to the GCT environment.
As well as the main view and the main menu, the main window will also display a small amount of global
status information such as the current date and time.

The menu bar window will, by default, remain permanently at the top of the screen while GCT 1s renaing.
The user will be able to select options from the mmain menu abt any time and with any combination of views
on screen, inappropriate menu items being ‘greyed out’ to indicate their unavailability.

The layout of the items in the menu bar will be as follows:

LR TR

 ONTROLLED DISTRIBUTION COPY | ROAIMENT | Group Configuration Tool
ONLY IF COLOUR STAMPED ON 1
CONTROL SHEET. Provisional Functional Specification

EU ROTH ERM E! DOCUMENT NUMBER SHT.

A Coanvrieht 1992 Earotherm Limited NO NUMBER, For Information Only 18




ite Utilities {(View)

Eelpﬂ;

Ezch item of the menu bar represents an entry point to & pull-down menu of associated functions.

Ezch of the pull-down menus corresponding to top-level menu items will now be described. Menu items which
lezd 10 a dialog box (e.g. to allow the setup of command options, or for confirmation) are followed by an

e[ipsis (...} when displaved.

File Menu

The File menu provides the means by which typical file-handling operations are performed on the type of
ohject in the current main view. Menu options typically apply to whatever objecis are currently selected in

he current main view — it 1s possible to select more than one object currently.

The File pull-down menu contains the following items:

!}ew Project. .. greyed out if nof on Project View
Open Project... | greyed out if not on Project View
Hove. .. greyed out if no objects selected In main view
Copy. . - greyed out if no objects selected In maln view
Delets. .. greyed out if no objects selected in main view
Print... greyed out if no objects selected in main view
Validate
Build. ..
Close
Exit...

+ File, New Project...

This item leads to a dialog box in which the user specifies the name of the project and the parent
directory under which it will be stored. It is greyed out if the main view is not a project, or if there are
any independent views active. [t resets the Project main view to the new (empty) project’s context.

s File, Open Project...

This item leads to a dialog box in which the user specifies the name of the project and the parent
directory under which it is stored. It is greyed out if the main view is not a project, or if there are any
independent views active. It resets the Project main view to the named projéct’s context.

s File, Move...

Moves the object(s) selected in the main view to another folder of the same type. E.g. move Resources
between Projects, move Block Types between Libraries. This option is greyed out if there are no selected
objects. A dialog box requests the destination of the move operation in terms that are suitable to the

object being moved.

» File, Copy...

Copies the object(s) selected in the main view to another folder of the same type. E.g. copy Resources

between Projects, copy Block Types between Libraries. A dialog box requests the destination of the

copy operation in terms that are suitable to the object being moved.

ONTROLLED DISTRIBUTION COPY | ROGHMENT 4 Group Configuration Tacl
ONLY IF COLOUR STAMPED ON 1
CONTROL SHEET, Provisional Functional Specification

EUROTHERM | g [rooeroe=

NO NTIMBER. For Information Only

A i ole 1A0A D amthares §imitad

SHT.

20

[ERE R

o aprEa



s File, Delete...

Deletes the object(s) selected in the main view.

« File, Print...

+ints the object(s) selected in the main view.
o File, Validate
V'alidates the definition of the selected objects without performing a full build.

. File, Build...

RBuilds the the selected objects into a (partially) runnable format.

+ File, Close

Closes the current main view. If the current view is other than the Project view the main view returns
to the Project View. If the current yiew is the Project view the main view returns o an empty Project
View {i.e. awaiting a File, ¥ew Project or File,Open Project}).

« File, Exzt...

This command is the primary means of terminating the GCT session. A dialog box will request con-
Armation of this command, and further dialogs will prompt the user io save any unsaved edits {with
options to save, discard edits ot abort the exit procedure}.

Unlities Menu

Tthis menu provides access to utilities which allow configuration of aspects of an application that are in addition
to she control sitategy, eg target-specific setup, etc. Tn the future this list will be expanded te Incorporate

more advanced features eg version control (see Fufure Utilities section below).

Tre Utilities pull-down menu contains the following items:

Library Browser
Windows. .. greyed out if there are no independent views

Set Up

» Utilities,Library Browser

This itemn invokes the Library Browse independent view

+ Ttilities, Windows...

This item invokes a dialog box for controlling independent views. It is a convenience utility for managing
screens with too many open windows. It includes a scroll list of all active independent windows and
button for raising, lowering and killing the selected window(s).

« Utilities,Set Up

This menu gives access to aspects of the GCT setup which will only occasionally need to be adjusted.
For example, user preferences on default size or position of new windows.

TR RRET T
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.

This menu may be reset according to the current main view to offer view specific functions.

Eealp Menu

This menu will give a number of access points to the help system. Initially a simple help system based on the
carrent X VT help engine will be used but this will later be extended to a full hypertex help.

The Help pull-down menu contains the foilowing items:

» Help, Index

Index
Commands
Keyboaxd

Tutorial

ibout...

This command opens a window on the help system containing an alphabetical list of subjects addressed

hy the help system.

e Help, Commands

This command opens a window containing a list of the entries in the top-level menu bar, from which the

user can access help on any

from the menu system.

e Help, Keyboard

individual pull-down menu and any in@ividual command which is available

Whereas mouse users should find GCT almoss totally intuitive, keyboard users will need special guidance
on such subjects as navigating between windows, closing windows, and moving between contzols in a
dialog box. This command opens a window on the help system which gives keyboard users an alphabetical
list of areas in which they may need assistance.

o Help, Tutorial

This command will give first time users an interactive run-through of the facilities provided by GCT.
The specification of this tutorial has yet to be defined.

o Help, About...

This command displays a dialog box showing a copyright message and GCT version information.

7.2.3 Project View

Figure 7 illsutrates the project view.

The project view provides a view of the Resources, Configurations, and Libraries (Project and Shared) asso-

ciated with the project.

At any one time the Project View shows a scroll list of either the Resources {default), Corfigurations, or

Libraries, together with “New” and “Open

” buttons that operate on the current item type (i.e. create a new

Resource or Open a selected Resource if the scroll list contains Resources).

From the Project View the user accesses items within a project and performs management functions on those

items,
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Figure 7: Main Project View
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¢

2.4 Library View

The Library maln view Dresents the contents of a single library. Opticn buttons allow the user to specify
whi-h block types will be mncluded or inhibited from block list eg function black, service, funciion, ste.

Trom the library view blocks may be selected for library management functions. Also the edit may be launched
+f z pew or 2xisting block in an independent view.

i

e

.5 Configuration View

o~
L

rr

: configuration view associates Resources with target nodes. Functionality includes

¢ Specifying which Resources are to Tun on which nodes.
s Defining network characteristics
« Downloading, starting, stopping Resources

« Launching a Resource editor in on-line mode.

7.2.8 FMC Target Support

A atility will be incorporated to allow configuration of target specific aspects of the FMC target system. This
wil be specified in more detail in conjunciion with the FMC project.

7.3 Independent Views

Independent views exist in windows separate from, and largely independent of, the main view. There can be
multiple active independent views, most of which will have their own menu bars.

7.3.1 Block View . -

The GOT block view will allow the display and modification of all application biock types.

The block editor will consist of a one, two or three pane window and a menu bar, with each window area
separated by a sash. The three panes will contain the interface, internals, and body views of a block.

The interface pane will provide a generic view of all block types, whilst the body view will be specific to the
implementation of the block, eg SFC, ST, or in the future, FBD, spreadsheet or other editors as required.

Iz on-line mode, the block views will allow access to run-time values and the editing options will be greyed-out.
Block Menu Bar

The layout of the itemns in the menu bar will be as follows:

File Edit Options Hel}i]
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e File Menu

The File menu provides the means by which sypical file-handiing operations are performed on the block
type. It contains the following items:

Validate

Build...

Close

]

— File, New...
This launches the creation of a new block type in the current independent view. The user is
prompted to save any changes to the existing biock type in the view.

— Fije, Open...
This launches the Library Browser to select a new block type to edit in the current independent
view. The user is prompted to save any changes t0 the existing block type in the view.

— File, Save
This item saves the current block to disk under its current name. Before saving to disk, a validation

traverse will be performed (see File, Validat &) to point out any errors to the user and, optionally,
allow them to be corrected. It will be possible, however, to save an invalid block to disk.

Tt is possible that the present block will not vet have a name. In this case the Save command wiil
perform a Save As (see below).

— File, Save As...
This command leads to a dialog box which enables the user to save the current block under a new
name, and optionally launches the library browser to select the library in which the biock 1s to be
saved,

— File, Print...
Prints the block.

— File, Validate
Validates the definition of the block without performing a full build of the block.

— File, Build...
Ruilds the block into a format suitable for incorperation into a runnable Resource.

— File, Close
Closes the independent main view. The user is prompted to save any changes to the existing block

type in the view.
s Edit Menu

The primary purpose of the Edit menu is to facilitate the cutting, copying and pasting of portions of
editable components, and the undoing thereof.

The Edit pull-down menu contains the following ltems:
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Undo

Cut
Capy
Paste

Delate

Search...

- Edit, Undo

Tindo will not be supported initially. This command will unde the mest recent Cut, Copy, Paste
or Delete operation. [t may be desirable for the text of the Undo itern in the pull-dewn menu to
he modided to show the type of operation which will be undone {e.z. Undo Paste). Consideration
should also be given to the possibility of implementing a stack of edit operations to facilitate multiple
undos.

Edit, Cut

This command will remove the currently marked portions of an editable component and place them
on the clipboard so that they may be subsequently pasted into another (or the same) editable
somponent of the same type. This command will be greyed out whenever there is no marked area.

Edit, Copy
This command will copy the currently marked portions of an editable component to the clipboard.
This command will be greyed out whenever there is no marked area.

Edit, Paste

This command will attempt to paste the clipboard contents into the current window.

in a text window, the pasted text will be inserted unless there is a marked area within the text
window, in which case the pasted text will replace the marked portion.

in a graphical window the paste operation is effectively an overwrite, but if this involves deleting
any portion of the existing window the user will be prompted to confirm this using a dialog box.
At this point he will also have the option of abotting the entire Paste comnmand.

Edit, Delete
This command will remove the currently marked porticns of an editable component without affect-
ing the current clipboard contents.

Tdit, Search... |

This command will not be supported initially. The command provides an entry point to an ST
search and replace mechanism. A dialog box is displayed, having data entry fields for search texs
and replace text, and radio buttons for the scope of the search (e.g. current block, current program
and entire configuration). Search text may be specified using regular expressions. There will be
command buttons for Search, Replace and Cancel.

Once a search or replace operation has been initiated, editable components coptaining the search
string will be displayed one after another. For the search operation a small dialog box will prompt
for Next or Cancel, while for replace another small dialog will ask for confirmation with the options
Yes, No, Global and Cancel.

+ Options Mean

The Options menu will allow the user to configure options that are local in scope, such as grid settings

for graphical editors.

¢ Help Menu

The Help menu provides a similar command set to that in she main menu’s heip pull-down, aad will also
provide access to the same help text as the main menu help. However, the initial entry points into the

help system will be relevant to the local context.
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1 Inrerface

The interface pane provides a generlc representation of all application block types.

The interface editor would be support:

&

Display interface declaration graphically (initially textually).
o Interactive help on specifying declaration type.
Wf « Inlberactive help on data types

i o Tnteractive help on declaration (e.g. edges, arrays, retain, etc).

Incernals

The internals pane provides a browsing facility for all components that are references within the body of the
biock.

The internals of a block with an SFC body would include steps, transitions and actlons.

T2 internals editor would support:

Display internals declaration graphically (initially textually).

« Tnteractive help on specifying declaration type.

Interactive help on data types

e Interactive help on declaration (e.g. constant, arrays, retain, ete).

Body

|

1{ The representation of the body of 2 block will depend on how it was originally defined. When the body of a
i pew block is first opened for edit, an option is given to select the body type. The selected editor will ther be
: invoked to allow the body to be defined. Thereafter the body will retain ifs body type attribute and whenever
% it is selected for display or modification, the respective editor is again invoked.
L

|

In some cases it will be paossible to display or traasform a block body into a simpler type {usually to ST
text), eg SFC to ST. It will not be possible to transform to a more compticated body type although default
generation of graphics may be supported in future releases.

Initially only ST text and SFC body editors will be supported. The details of the interaction of these body
views are described in later sections.

Block Types

The following sub-sections describe features of the specific block types supported. In each case the editors
that are appropriate for the definition of a body for a block of the given type are listed (those in brackets refer
to future releases of GCT).

» Configuration:

The first release of GCT will not include the configuration level, in other words, configurations will
consist of a single resource.

ONTROLLED DISTRIBUTION COPY | DOGTBMENT | Group Configuration Tool
ONLY IF COLOUR STAMPED ON
CONTROL SHEET. 1

Provisional Functional Specification

EUROTHERM E‘ DOCUMENT NUMBER SHT.

/A (anvrisht 1009 Furatherm Limited NO NUMBER, For Information Only 27




-~ Iaterface: Mone.
— Iaternals: Resource declarations.

— Bodv mav be defined in: ST, (FBD).
¢ Resource:

] — Tnterface: None.
- laternals: Task, Service, Program, Function Block declarations.
— Body may be defined in: ST, (FBD}.

+ Task:

— Interface: None.
— Internals: None.

— Body may be defined in: Display list of task assoclations.
s Service:

— Interface: Inputs, Outputs.
— Internals: declaraiions {includes steps, transitions and actions if SFC body).
- Body may be defined in: 5T, SFC, (FBD).

s Program:

— Interface: None.
— Internals: declarations (includes steps, transitions and actions if SFC body).
- Body may be defined in: ST, SFC, (FBD).

¢ Funciion Block:

_ Ipterface: Inputs, Outputs, Input_Outputs.
-~ Internals: declarations {includes steps, trapsitions and actions if SFC body).
~ Body may be defined in: ST, SFC, (FBD).

¢ Function:

— Interface: Inputs, single cutput{implicit}.
- Internals: declarations.
— Body may be defined in: ST, (FBD).

e Siep:

— Interface: Executing, Time, (Finished) parameters.
— Internals: Action associations.

~ Body may be defined in: None.
e Transition:

— Interface: None.

— Internals: None.
- Body may be defined in: ST, (FBD).

e Action:
— Interface: Qutput.

transitions if SFC body.
— Body may be defined in: ST, SFC, (FBD).

_ Internals: None - uses declarations of POU in which action is defined. Will include steps and
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7.3.2 Library Browser

The library browser view allows the user to browse and select blocks 1n lipraries. The effect of selecting 2
bleck will depend on the context in which the browser is invoked., This may include launching an edit of the
block tvpe {in an independent view), enabling library management functions in the main view, etc.

The Library Browser operates on a list of libraries that is associated with a project. [t will support the
following;:
» List libraries,

o List blocks within libraries.

» Allow the user to specify which block types will be included or inhibited from block list eg function
block, service, function, etc.

« An exdsting or new block may be opened in a new block edit independent view.

7.2.3 Trace

4 trace facility will provide a non-intrusive means of run-time diagnostics. A trace specification may be defined
and downloaded and trace data can be collected from the target system and displayed. Trace specifications
can be stored on file for later retrieval. Initially the trace utility will be based on the FMC trace gpecification
but it is hoped that this will be of general use in the future.

8 SFC Editor

This editor, based on the IEC DIS 1131-3 Sequential Fuction Chart (SFC) eraphical language (see ), will
kandle the configuration of steps, transitions, and alternate and parallei sequences.

Features of the GCT SFC editor will inciude:

The SFC editor will present a pallette of tool options.

Placing of steps and transitions. will be constrained to the SFC grid.

Connecting lines will be contrained to orthogonal polylines. Bends in connections will be constrained to
the SFC grid.

o A simple move facility will allow a single selected step, transition or connector te be moved. Any
connections will be stretched.

»

An object in the work area, eg a step oI trapsition, may be opened for display and editing.

« Cut and Paste will be accesible via the menu bat. Initially this may be restricted to single SFC cbjects.
Tools available in the tool pallette will include:

+ Step
The Step tooi will allow the placing of steps in the SFC work area.
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+ Start Step
The siart step tool will allow the start atiribute of a step to be modified. A single body may have
muitiple SFC networks, but ench network may only have a single start step. This tool may be used to
suppor: other attributes in the future.

» Transition

The Trapsition tool will allow the placing of traasitions in the SFC work area.

« Connest
The conpect tool will allow the wiring of steps and transitions.

A step may not be directly connected to another step. A transition may not be directly connected to
znother transition.

{pticn will be given for routing at connect time. Direct connection will result in anbo-routing.
Define route from source to destination of conmector.

Source and destination connection points will be highlighted when appropriate.

A connector will be allowed to hang loose a) when created, b) when object connected to is deleted.

1f connections are made such that a transition has more than one following steps, the connections will
become an activatlon.

I¢ connections are made such that a transition has more than one preceding steps, the connections will
become an rendez-vous.

T connections are made such that a step has more than one following transiticns, the connections Will
become an alternate selection.

Connectors that represent Activation, Rendez-Vous, Aliernate Divergence or Alternate Convergence
constructs are known as complex connectors.

Fragments of a complex connector may be selectivly deleted.
Move object results in connections being stretched (defauit routing}.

More complex facilities for editing connectors may be added later: e.g. add points, move points, delete
points. Initizlly editing will be done via create and delete.

o Delete

When the delete tool is active, steps, transitions or connectors may be selected for deletion. Fragments
of a complex connector (Activation, Rendes-Vous, Alternate), may be selectively deleted depending on
the position they are selected.

¢ Draw

A draw tool will be used to place textual or graphical information, freely within the work area (not
supported initially).

« Group LATER

» Ungroup LATER

¢ Zoom in LATER

+ Zoom out LATER

« Undo LATER

The UNDO facility will require a record to be kept of operations performed. Ideally a two level UNDO
will be supported.

e Redraw

The redraw tool will allow refreshing of the work area.
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i 9 ST Editor

The ST editor will be a simple text editor based on the XVT fFacilities. ST text will be saved and blocks will
be validated by the CDL Object Manager.

{ Ia “act, the ST editor will support the Configuration Definition Language {CDL) (see {2]) superset of the IEC
DIS 1131-3 Structured Text (ST) language (see [1]}, which uses ST for the specification of all run-time aspects.
(DL incorporates extensions to ST for the specification of attributes that are used for display purposes as
weil as other important exiensions to the language.

“TLis editor will allow the textual definition of almost all aspects of a resource from the top layer of a resource
down to a parameter attribute. Depending on the nature of the block being edited, the editor may in fubure
assist the user by performing syntax checking and by providing templates for the textual definition.

It wiil be possible to import free format ST text from a file, into a block definition.

10  Future Utilities

10.1 Hierarchical Browser

The browser utility will be accessible at all times.
The browser will be hierarchical and will allow access to all levels of application data.

The browser will enable the user to browse definitions of all application entities:

¢ Configuraticns
¢ Resources

¢ Tasks

s Services
i s Programs
e SFCs
' » Steps within SFC POU
| s Actions within SFC POU
s Function Blocks
« Functions

s Variables within POU

Multiple instances of the browser may be active concurrently.
The browser may be initialised o a given context and/or scope.

i
’ Additional operations on a selected object may be accessed via the browser: e.g. Open, New, Build, Verify,
!

Delete.
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10.2 User Screen Definition

This ucility will allow the definition of

provided by the PC3000 Programming Software.

10.2 Diagnostics

Diagnostics utilities will show information eg cn task overruns an

probably be target specific.

10.4 Simulation and Debug

The ability will be provided to simulate the running of app

simulated behaviour of the physical I/O (which need not be present).

taxtual user screens for debug purposes similar to those currently

d system errors ete. Diagnostic utilities will

lcations off-line, enabling the user to specify

It will ziso be possible to access specialised debueging facilities when on-line: e.g. one-shot execution of tasks,
P P =1} =]

SF(s, function blocks ete.

10.5 Source and Version Control

This facility will enable the user to save and manage different versions of his applicaticn sou
with release numbers when required, and will a

10.6 Additional Target Support

ree, tagging them

llow him to revert to any of the previous versions at any tlime.

Additional utilities will provide support specific to 2 given target system (e.g. Production Orchestrator,

PC3000, TL00O, etc).

In the case of PC3000, for example, this facility will ena

ble the user to specify the required configuration of

hardsware modules within any of the PC3000 resources in the system. This facility will act in a more ‘intelligent’

manner than the equivalent provision of the current P
laving out the configuration, the har
been assigned and allowing him to mate

Whatever the target system, this facility will

standard GCT utilities.

10.7 FBD Editor

The IEC DIS 1131-3 Function Block Diagram (
ponents at different levels within the configuration hierarchy (

block, function). In practice there will be a single ¥BD editor that w1

to context.

dware management u

S the user will be allowed to allocate ‘virtual’ 1/0O when
tility later showing him the virtual I/O which has
h this to actual [/O modules as required.

include only those features which are not supported by the

FBD) graphical language (see {1]) will be used to configure com-
e.g. configuration, resource, program, function
11 operate in different modes according
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10.8  Other Editors

Other editors may be incorporated into the GCT framework eg the MICS spreadsheet editor.

11 GCT Topics

The following sub-sections summarise the manner in which GCT supports a number of topic areas through
its various views.

11.1 Help

[nteractive Help on all aspects of GUT interaction will be built in to 2l GCT views.

11.2 Cut And Paste

GOT cut and paste will be based on the XVT cut and paste facilities. XVT employs 2 single clip board which
is capable of carrying muitiple representations of objects. In the future it will be nossible to cut and paste
beiween different editor types, eg an ambitious example would be from a spreadsheet editor to an S¥C editor.
Initially simple cut and paste of text will be supported.

11.3 Application Documentation

GCT will support the ability to add descriptive (initially textual, bul later to incude graphical} information
to application components.

A hardcopy of application documentation may be generated for each Configuration, Resource or Block defini-
tion. This will be accessible via the Print command in the Project pull-down of the main menu or the Block
pull-down of individual view menus.

11.4 Run-Time Facilities

GCT will enable the user to manage the building, downloading and executing of applicaticas. This will be
accessible via the menu bar options of the Project and Library {build only) views.
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